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Qualified Persons  WARNING
The equipment covered by this publication must be installed, operated, and  
maintained by qualified persons who are knowledgeable in the installation,  
operation, and maintenance of overhead electric power distribution equipment 
along with the associated hazards . A qualified person is one who is trained and 
competent in:

• The skills and techniques necessary to distinguish exposed live parts from nonlive 
parts of electrical equipment .

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed .

• The proper use of the special precautionary techniques, personal protective  
equipment, insulating and shielding materials, and insulated tools for working on or 
near exposed energized parts of electrical equipment .

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this 
type of equipment .

Read this Instruction 
Sheet

Thoroughly and carefully read this instruction sheet before programming, operating, or 
maintaining your S&C IntelliRupter PulseCloser Fault Interrupter. Familiarize yourself 
with the Safety Information on page 3. The latest version of this instruction sheet is 
available online in PDF format at sandc.com/en/Support/product-literature/asp.

Retain this Instruction 
Sheet

This instruction sheet is a permanent part of your S&C IntelliRupter PulseCloser 
Fault Interrupter. Designate a location where you can easily retrieve and refer to this 
publication. 

Special Warranty 
Provisions

The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheet 150, applies to IntelliRupter fault interrupter and its associated options 
except for the control group (the protection and control module and communication 
module) and S&C SpeedNet™ Radio, as applicable. For these devices the first paragraph 
of said warranty is replaced by the following:

(1) General: The seller warrants to the immediate purchaser or end user for a period 
of 10 years from the date of shipment that the equipment delivered will be of the kind and 
quality specified in the contract description and will be free of defects of workmanship 
and material. Should any failure to conform to this warranty appear under proper and 
normal use within 10 years after the date of shipment, the seller agrees, upon prompt 
notification thereof and confirmation that the equipment has been stored, installed, 
operated, inspected, and maintained in accordance with recommendations of the seller 
and standard industry practice, to correct the nonconformity either by repairing any 
damaged or defective parts of the equipment or (at the seller’s option) by shipment of 
necessary replacement parts. 

Replacement control groups and S&C SpeedNet Radios provided by the seller or 
repairs performed by the seller under the warranty for the original equipment will be 
covered by the above special warranty provision for its duration. Replacement control 
groups and S&C SpeedNet Radios purchased separately will be covered by the above 
special warranty provision.

This warranty does not apply to major components not of S&C manufacture, such 
as batteries and communication devices, as well as hardware, software, resolution 
of protocol-related matters, and notification of upgrades or fixes for those devices. 
However, S&C will assign to the immediate purchaser or end user all manufacturers’ 
warranties that apply to such major components.

Use the Latest 
LinkStart Software 
Revision

Install the latest IntelliRupter fault interrupter software on your computer—available at:  
sandc.com/en/support/sc-customer-portal/. This is the latest version of LinkStart 
software. If LinkStart encounters earlier software on a Wi-Fi card, it will require that 
you automatically update that software, and then proceed with your Wi-Fi tasks.

Introduction
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Understanding 
Safety-Alert Messages

Several types of safety-alert messages may appear throughout this instruction sheet 
and on labels attached to the IntelliRupter PulseCloser Fault Interrupter. Familiarize 
yourself with these types of messages and the importance of these various signal words:

 DANGER
“DANGER” identifies the most serious and immediate hazards that will likely 
result in serious personal injury or death if instructions, including recommended 
precautions, are not followed .

 WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious per-
sonal injury or death if instructions, including recommended precautions, are not 
followed .

 CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor per-
sonal injury if instructions, including recommended precautions, are not followed .

NOTICE
“NOTICE” identifies important procedures or requirements that can result in prod-
uct or property damage if instructions are not followed .

Following 
Safety Instructions

If you do not understand any portion of this instruction sheet and need assistance, 
contact your nearest S&C Sales Office or S&C Authorized Distributor. Their  
telephone numbers are listed on S&C’s website sandc.com Or call S&C Headquarters  
at (773) 338-1000; in Canada, call S&C Electric Canada Ltd. at (416) 249-9171.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating your S&C IntelliRupter 
PulseCloser Fault Interrupter .

Replacement 
Instructions  
and Labels

If you need additional copies of this instruction sheet, contact your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be 
replaced immediately. Replacement labels are available by contacting your nearest 
S&C Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric 
Canada Ltd.

Safety Information
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Overview

This document is applicable to IntelliRupter Installer versions 2.29 through 3.49, which 
only operate with Wi-FiAdminInstaller 1.0.0. For IntelliRupter Installer version 3.5.x and 
ater refer to S&C Instruction Sheet 766-522.

Two programs are used to generate security keys. WiFiKeys creates the key files, 
and DBEdit database editor assigns keys to specific IntelliRupter fault interrupters.The 
distribution engineer or a security administrator has responsibility for authentication key 
security.  The most secure procedure is installing the WiFiKeys program on a security 
personal computer (PC), and installing the DBEdit program on a separate database PC.  
Keys generated on the security PC are then transferred to the database PC with a secure 
means, such as by using a USB thumb drive. The WiFiKeys program, by default, saves 
key files in the LinkStart folder. The DBEdit and LinkStart programs also store files in a  
LinkStart Folder, located at:  \Documents and Settings\All Users\Application Data\
S&C Electric\LinkStart\. This folder requires administrative privilege and uses folder  
security for access to existing files and for adding new files. Transferring data is simple— 
using administrative and folder privileges on both computers, move the files from the 
security PC LinkStart folder to the database PC LinkStart folder.

NOTICE
The key files are generated on the security PC .  For each named key there will 
be two files, one with a “ .pub” file name extension and one with a “ .pri” extension . 
Both files are part of a single “key pair” half used by a Wi-Fi module and the other 
half by LinkStart . It is important to backup and properly manage the key files . 
When a key is generated it can never be regenerated . This means the WiFiKeys 
program will not duplicate a key set if the same key name is used . Instead of 
duplication, two different sets of key files will have the same name . Take care 
to avoid this situation, so sers will not be locked out because they are using the 
wrong key which has the right name .

For authentication purposes, the LinkStart program encrypts specifically defined 
data with its private key, so it can be decrypted by the Wi-Fi module using the public 
key on the mobile computer. The Wi-Fi module, in turn, encrypts different specifically 
defined data with its private key, so it can be decrypted by LinkStart using the Wi-Fi 
module’s public key.  This requires that the Wi-Fi module be supplied with a private key 
and a different pair’s public key and that LinkStart be supplied with the public part of 
the first key pair and the private part of the second key pair.

The DBEdit program expects to find both the required key files present in the  
LinkStart folder and will use the private and public keys for the key names specified in 
the MasterKey.txt file created by the Master Key Entry screen.  When the config file is 
exported by DBEdit, it should then be transferred to the portable PC that will be used 
in the field to transfer the config file to specific IntelliRupter fault interrupters.

If the two key names for master keys are:  IntelliRupter Master Key: MasterIR, and 
Mobile Master Key: MasterLT, then DBEdit will require that the files MasterIR.pri and 
MasterLT.pub both be present so it can include them in the config file. However, it will 
not expect the other files from these two pairs (MasterIR.pub  MasterLT.pri) to be in 
the LinkStart folder.

The file needed for configuring IntelliRupter fault interrupters to use master keys 
will have the extension “.wm” and will include either the individual serial number of 
the IntelliRupter fault interrupter or the universal serial number: install.00-0000000.wm 
depending on the choice used when exporting from DBEdit. The files needed for any 
LinkStart program to connect to an IntelliRupter fault interrupter AFTER it has been 
loaded with the config file install.00-0000000.wm would be the files not included in the 
config file: MasterIR.pub  MasterLT.pri.  

The portable PC used to upload the .wm file should have both the .wm file and the two 
separate key files. Any other portable PCs that connect to the IntelliRupter fault inter-
rupters after the config file has been uploaded will only need to have the two separate 
keyfiles:  MasterIR.pub  MasterLT.pri.
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Overview

Follow these steps to create and install IntelliRupter master keys:
STEP 1. On the security PC, make two key files with the Wi-Fi Key Generator program. 

From these two files the Wi-Fi Key Generator program will generate four key 
files that will be saved in the LinkStart folder. See page 6.

STEP  2. Copy the four key files stored in the LinkStart folder on the security PC to a USB 
thumb-drive. Insert the thumb-drive in the database PC and paste the four files 
into that LinkStart folder. 

STEP  3. Open the DBEdit program on the security PC, and enter the key names in the 
Master Key Set dialog box. See page 8.

STEP  4. Add all the IntelliRupter fault interrupters to the DBEdit database list. See 
page 11.

STEP  5. Generate a Wi-Fi Configuration file.  See page 15.

STEP  6. Generate the Master Key Configuration filet hat is saved in the LinkStart folder. 
See page 16.

STEP  7. Save the Master Key Configuration file, the IntelliRupter fault interrupter 
public key, and the laptop private key in the LinkStart folder on the portable 
computer that will be used to connect with Wi-Fi to IntelliRupter fault 
interrupters in the field. If using the example file names that were used in the 
beginning of the “overview” section, install.00-0000000.wm, MasterIR.
pub, and MasterLT.pri would be used.

STEP  8. When at an IntelliRupter fault interrupter in the field, start LinkStart on the 
portable computer. Select the device name or serial number for that IntelliRupter 
fault interrupter and connect to it. See page 17.

STEP  9. Click on the Wi-Fi Admin button and log in to LinkStart with an  
administrative password. On the Wi-Fi Configuration and Setup dialog box, 
click on the Transfer Wi-Fi Settings button to load the master key set into 
the IntelliRupter fault interrupter’s Wi-Fi module. See page 18.

Follow these steps to remove your IntelliRupter Master Keys:
STEP 1. Open the DBEdit program on your database PC. Disable the Master Keys 

option. See page 24.

STEP  2. Generate an empty Master Key Configuration file, which is saved to the 
LinkStart folder. See page 25. 

STEP  3. Save the empty Master Key Configuration file in the LinkStart folder on the 
portable computer to be used to connect with Wi-Fi to IntelliRupter fault 
interrupters in the field. The LinkStart folder must contain a copy of the active 
key until they have been removed from the Wi-Fi module.

STEP  4. When at an IntelliRupter fault interrupter in the field, start LinkStart on the 
portable computer. Select the device name or serial number for that IntelliRupter 
fault interrupter and connect to it. See page 17.

STEP  5. Click on the Wi-Fi Admin button and log in to LinkStart with an  
administrative password. On the Wi-Fi Configuration and Setup dialog box, 
click on the Transfer Wi-Fi Settings button to load the master key set into 
the IntelliRupter fault interrupter’s Wi-Fi Module. See page 18.
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Wi-Fi Authentication Key Generator

Before telling the DBEdit program the names of the master keys to use during 
authentication, keys must be generated using the WiFiKeys program. See Figure 1.

The screen shown in Figure 1 shows the default path to the folder where the keys 
will be written. Both DBEdit and LinkStart look in this folder for the keys and the 
database files.

To generate the keys needed as master keys, select two names—one for the 
IntelliRupter fault interrupter  and one for the PC computer. Type the name into the 
Name for the key pair field and click on the Make Key button. The screen shows the 
names of the two keys generated. See Figure 2.

Figure 1. The Wi-Fi Key Generator screen.

Figure 2. Naming the key pair.
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Wi-Fi Authentication Key Generator

Repeat this process for the second key name. See Figure 3.

Now the key files (four of them) have been saved in the LinkStart folder, where the 
DBEdit program will look for them. If sing two separate computers, move these files 
from the security PC to the LinkStart folder on the database PC. 

Each time a key is generated it is unique. Therefore, a lost key cannot be replaced 
by re-entering that key name. A completely unique key will be generated the second 
time the same name is used, and the new key cannot be used to replace the first key.

Figure 3. Repeat the key-naming process for the second key.
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Database Editor Program

The first time the DBEdit program is run after installation, the screen shown in  
Figure 4 appears, overlaying the main DBEdit screen.

Note in Figure 6  the addition of the Master Key button, with text at the right. Clicking 
the Options button will reopen the IntelliRupter Security Architecture Options dialog 
box, allowing changes to be entered. The following screen shows the configuration for 
default security only, with no company-specific keys.

Clicking on the Provide for Master Key checkbox and clicking on the Save button 
configures the DBEdit program to work with a pair of master key names to provide 
company-specific authentication security during the connection setup between a PC 
computer and an IntelliRupter fault interrupter.

Figure 5 shows the main DBEdit screen before the Provide for Master Key option 
is selected.

DBEdit Program

Figure 4. The screen overlaying the DBEdit screen.

Figure 5. The main DBEdit screen.

Figure 6. The addition of the Master Key button.
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Database Editor Program

Click on the Master Key button on the main DBEdit screen. See Figure 7.

The Master Key Set dialog box will open. See Figure 8.

Enter Master Key 
Name

Figure 7. Click on the Master Key button.

Figure 8. The Master Key Set dialog box.
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Database Editor Program

Enter the two key names here. click on the Save button, then click on the Exit button.

The names will now appear on the main screen to the right of the Master Key  
button. See Figure 10.

Figure 9. Entering the two key names.

Figure 10. Key names now appear next to the Master Key button.
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IntelliRupter fault interrupters can now be added to the database. If there is  an existing 
database file named MBL DB.csv, use Microsoft Excel to convert that database. See the 
“Excel File Examples” section on page 28 for the conversion procedure. The default 
file created when the program ran the first time has one record, the Universal Serial 
Number, which can address any Wi-Fi module that is not connected to the control in 
an IntelliRupter fault interrupter.

To enter new information, first click on the Insert button to create the line for the 
new entry. This opens the Edit screen where IntelliRupter fault interrupter information 
can be entered. If multiple entries exist in the database, the new line will be inserted 
below the line that is selected in the database list. See Figure 11.

Click in each field to type in the information. When an entry has been completed, 
click on the Done button. See Figure 12.

Add IntelliRupter Fault 
Interrupters  
to the Database

Database Editor Program

Figure 11. The Wi-Fi Database Management Edit screen.

Figure 12. Entering database information.
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Database Editor Program

This will transfer the data to the main screen on the next line. See Figure 13.

Repeat this process to enter information for each IntelliRupter fault interrupter. 
Click on the Insert button and type information in the Edit screen for each new record 
added to the database.

The device name cannot contain spaces, but spaces are allowed in the Device  
Location field. 

To edit an existing entry, select it and double click on the entry line. This will open 
the Edit dialog box.

Figure 13. Data gets transferred to the next line.
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Database Editor Program

The same file name can be created using Notepad, and the entry can be saved as LSDB.
txt into the LinkStart folder. When entering data, be sure to always end each line by 
pressing the Enter key on the keyboard.

It is important to press the Enter key on the keyboard at the end the last line of text. 
Failure to do this prevents recognition of the last record. See Figure 14.

Data Entry  
with Notepad

The text file can also be loaded by DBEdit when it is placed in the same folder as the 
key files, the LinkStart folder.

Files can also be created and edited in Excel. Save the file using the tab delimited 
*.txt file extension, and Excel will add tab character field delimiters. Using Excel is 
described in a later section.

This is the Notepad file loaded by DBEdit. See Figure 15.

Figure 14. Press the Enter key on the keyboard at the end of the last line of text to recognize 
the last record.

Figure 15. The Notepad file loaded by DBEdit.
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Database Editor Program

Similarly, an Excel spreadsheet saved as a tab-delimited text file can be loaded into 
DBEdit. See Figures 16 and 17.

When records have been added, click on all the required records, click on the Save 
button to preserve the data.

Figure 16. An Excel spreadsheet saved as a tab-delimited text file.

Figure 17. The Excel spreadsheet loaded into the DBEdit screen.
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Wi-Fi Configuration File

A Wi-Fi configuration file generated by the DBEdit program contains the Wi-Fi settings 
described below and the Authentication Security Key files. This file loads into the Wi-Fi 
module to configure it for security. Using a master key set requires that only a single 
configuration file be generated and loaded into all IntelliRupter fault interrupters. When 
this approach is used, the configuration file should be generated from the universal serial 
number and only the universal serial number will require its settings to be configured. 
Alternatively, each IntelliRupter fault interrupter Wi-Fi Module can be loaded with a 
unique configuration file based on the IntelliRupter serial number. If this approach is 
taken, then each device in the database will require a unique configuration setting file.

To configure the WAN radio serial port settings and the Wi-Fi administrative pass-
words, select the IntelliRupter fault interrupter, or the universal serial number, from 
the main DBEdit screed by double-clicking on it to open the Edit screen. See Figure 18.

Now click on the Settings button. See Figure 19.

The Baud Rate (Bits/Sec), Data Bits, Parity, Stop Bits, and Flow Control settings 
for the selected device can be changed from the screen shown in Figure 19. Click on 
the down arrow icon to display a list from which to select the value for the parameter 
being changed.

The user and admin passwords can also be changed here  by clicking in the appropri-
ate field and typing in a password.

When finished, click on the Save button and on the Exit button. These settings are 
recorded in a .ini file and will now remain associated with this device.  The universal 
serial number can also have an .ini file: “00-0000000.ini”.

Figure 18. Opening the Edit screen.

Figure 19. The Wi-Fi Module Settings screen.
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Wi-Fi Configuration File

Generate Master Key  
Configuration File

Click on the Export button on the main DBEdit screen to open the Export Configuration 
and Database Files dialog box. To generate a universal configuration file from the 
universal serial number—click on (select) the universal serial number 00-0000000 
and click on the Export button. This will generate the Master Key Configuration File: 
install.00-0000000.wm in the LinkStart folder. See Figure 20.

To generate configuration files for each device, select the serial number or serial 
numbers to generate the configuration files for, and click on the Export button. A 
configuration file containing the serial number in its name will be generated for each 
of the selected serial numbers.

The database is now ready for use. 

Decrypting a  
Master Key  
Configuration File

To view the contents of a Master Key Confirmation File that has either the .vm or .wd 
file extension, click on the Decrypt Files button on the main DBEdit screen to open 
the Config File Decryption screen. Click to select the name of the file to view, and click 
on the Decrypt File button. See Figure 21.

Figure 20. The Export Configuration and Database Files screen.

Figure 21. The Config File Description screen.
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Connecting to an IntelliRupter Fault Interrupter

Start LinkStart and select the IntelliRupter fault interrupter to connect to. Scroll through 
the database by clicking on the Prev and Next buttons, or click on the Clear button 
and type text into the Device Name field to perform a dynamic search of the database.  
When the deisred record appears in the drop-down list, click on it to select it.

Click on the Connect button. See Figure 22.

After the connection is established, click on the Wi-Fi Admin button and log in using 
the administrator password. See Figure 23.

Figure 22. Scrolling through the database.

Figure 23. The Wi-Fi Admin button is on this screen.
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Sending Configuration Files

When logged in, click on the Transfer Wi-Fi Settings button. See Figures 24 and 25.

Notice that install.00-0000000.wm is displayed as the available file. 

The Get button can be used to pull a copy of the existing settings file prior to upload-
ing the new settings file.  If selected, a file with the name install.XX-XXXXXXX.wd, 
where XX-XXXXXXX = the serial number of the connected device, will be created in 
the directory containing the new settings file.

If you are working with a docking station it is necessary to check the Override Base 
Memory at next power-on check box and click on the Apply button.  This will cause 
the security information to be written to the base memory module (BMM).  If this box 
has not been checked, the data in the base memory will overwrite the new configura-
tion in the Wi-Fi module.  The same is also true when transferring a communication 
module from an IntelliRupter fault interrupter with an updated BMM to one that does 
not have an updated BMM.

Now, click on the Send button to upload this file to the IntelliRupter fault interrupter’s 
Wi-Fi module and base memory module.

Click on the Done button, and then click on the Log Out button.

Figure 24. Click on Open Transfer Wi-Fi Settings button.

Figure 25. The Wi-Fi Configuration and Setup screen.
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Loading Wi-Fi Keys with IntelliLink Remote Setup Software

A Wi-Fi configuration file can be sent to an IntelliRupter fault interrupter with 
IntelliLink® Remote Setup Software. The latest IntelliRupter fault interrupter software 
must be installed on both the IntelliRupter fault interrupter and the portable PC 
computer. The configuration file is saved on the IntelliRupter Compact Flash card, and 
then the file is installed from the Compact Flash Card. Follow these steps:

STEP  1. Copy and then rename the Master Key Configuration file from install.XX-
XXXXXXX.wm to WIFICTRL.WFM.

STEP  2. Log in to the IntelliRupter fault interrupter with IntelliLink Remote Software.

STEP  3. In the IntelliLink Remote Software menu bar, select: Tools>Compact Flash 
Access...

STEP  4. Navigate to the Compact Flash Card Settings folder. See Figure 26.

STEP  5. Navigate the PC File System to the location of the renamed configuration file 
WIFICTRL.WFM. You may need to allow view system files in the Tools>Options 
menu.

STEP  6. Upload the file WIFICTRL.WFM from the PC File System to the Compact 
Flash Card. You may need to select the YES option to overwrite the existing 
file.

STEP  7. Close Compact Flash Explorer.

STEP  8. In the IntelliLink software screenset, select Setup>Communications>Wi-Fi. 
See Figure 27 on page 20.

Figure 26. The Compact Flash Card screen.
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Loading Wi-Fi Keys with IntelliLink Remote Setup Software

STEP  9. On the Wi-Fi screen, click on the Install button. Then, select the Transfer 
Configuration option and and click on the OK button to load the new Wi-Fi 
settings file from the Compact Flash card.

STEP  10. Verify that transfer status is complete.

STEP  11. To check this procedure, take the portable PC to the IntelliRupter fault 
interrupter in the field, and log on via a Wi-Fi connection with the proper keyset.

Figure 27. The Wi-Fi setup screen.
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LinkStart Database Searches

The first time LinkStart is run, the first record of the database is displayed. See Figure 28.

Clicking on the Clear button prepares LinkStart to search for a character or string 
of characters that appear anywhere in the main database file. See Figure 29.

Figure 28. The LinkStart screen displays the first database record.

Figure 29. The LinkStart Search screen.
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LinkStart Database Searches

Typing even a single character in the Device Name field opens a drop-down list of 
matches. See Figure 30.

Typing another character narrows the search results. See Figure 31.

Clicking on an IntelliRupter fault interrupter in the match list causes it to be selected. 
Clicking on the Connect button would link to that device. See Figure 32 on page 23.

Figure 30. The drop-down list of search matches.

Figure 31. Narrowing the search.
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LinkStart Database Searches

When the IntelliRupter Installer has been loaded on a portable PC, follow the  
procedures outlined in the “Connecting to an IntelliRupter Fault Interrupter” and “Send-
ing Configuration File” sections for each IntelliRupter fault interrupter to be configured.

For the most secure key management, copy only those files needed to a specific por-
table PC. After the IntelliRupter fault interupters have been configured with the master 
keys, remove the .WM file from the PC that uploaded the master keys.

S&C recommends preserving copies of the original key files in a secure place. If ALL 
copies of a key are lost, there is no “back-door” means to re-create the key.

Figure 32. Connecting to a specific IntelliRupter fault interrupter.
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Removing IntelliRupter Fault Interrupter Master Keys

There is no way to gain access to an IntelliRupter Wi-Fi module without the correct 
master keys once the Wi-Fi module has been configured with master keys. If the master 
keys are lost, the communication module will have to be returned to the factory to have 
the factory defaults restored. As long as the configured master keys are available, the 
factory default keys can be restored at any time with the following procedure.

To remove master keys and restore the factory default security keys, run the DBEdit 
program. From the main screen, click on the Options button and uncheck the Provide 
for Master Key check box, shown in Figure 33. Click on the Save button, click on the 
OK button on the confirmation dialog box, and click on the Exit button.

The Master Key button has now been removed from the main DBEdit screen See 
Figure 34.

Figure 33. Uncheck the Provide for Master Key checkbox.

Figure 34. The DBedit screen without the Master Key button.
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Removing IntelliRupter Fault Interrupter Master Keys

Follow the instructions on pages 16 through 18 to generate and deploy an empty key 
file. The empty key file overwrites the existing key file, removes the master keys, and 
re-enables the factory defaults.

If examining the Master Key Configuration File with the Config File that was gener-
ated after the Provide for Master Key check box was unchecked, notice that there are 
no Master Key files listed at the bottom of the list on the left. Compare Figure 35 with 
the Figure 21 on page 16.

Figure 35. The Config File Decryption screen.
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Converting  
MBL_DB.csv to  
LSDB.txt

Information can be typed directly into an LSDB.txt file, or the file type can be converted,  
as described in the next steps.

Locate the MBL_DB.csv file in the folder: \Documents and Settings\All Users\Appli-
cation Data\S&C Electric\LinkStart\Keyfiles, and make a backup of the file. Open 
this file with Microsoft Excel. The order and quantity of columns may vary depending 
on the version of LinkStart used to create this file. See Figure 36. 

Delete all of the columns except the column containing serial numbers typically 
labeled “Serial,” the column containing device names typically labeled “Name,” and the 
column containing device locations typically labeled “DeviceLocation.”

To delete a column, move the mouse cursor over the letter of the column to be 
deleted and click to select the column. Column A, in the screen shown in Figure 37, 
shows what a selected column looks like. Then, right click on the column letter to open 
the Options menu and click on the Delete option. Repeat this process until only the 
“Serial,” “DeviceName,” and “DeviceLocation” columns remain.

Microsoft Excel File Examples

Figure 36.The MBL_DB.csv Excel file.

Figure 37. How a selected Excel column appears.
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Next, select Row 1, the title row, by moving the cursor over the number in the far-left 
column of the row and click it. The screen in Figure 38 shows a selected row. Right click 
on that number to open the Options menu and click on the Delete option. See Figure 39.

Microsoft Excel File Examples

Figure 38. Right click to select a row.

Figure 39. Click on the Delete option.
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The dialog box shown in Figure 41 will open. Click on the Yes button to close Excel.

In the Excel menu bar select File>Save As... to open the Save As dialog box. See 
Figure 40. Browse to the location to save the new database file. The default location is 
D:\Documents and Settings\All Users\Application Data\S&C Electric\LinkStart. Enter 
“LSDB.txt” as the file name. Use the Save as type: pull-down box to select the Text 
(Tab delimited) (*.txt) and click on the Save button.

Microsoft Excel File Examples

Figure 40. The Excel Save As dialog box.

Figure 41. The Excel format selection dialog box.
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Figure 42 shows an example of a converted database.

Microsoft Excel File Examples

Figure 42. An example of a converted database.
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Microsoft Excel File Examples

A new LSDB.TXT file can easily be created in Excel.

Starting from a “New” Excel workbook, enter the fields manually See Figure 43. 
Save it as LSDBe.xls (different name, in this example, to prevent overwriting the ‘real’ 
LSDB.TXT file).

Then, enter the Save As information using the same file name, but chose the Save 
as type to be a Text Tab Delimited (*.txt) file. See Figure 44.

Excel then warns that it will only save one sheet—the active sheet.  Click on the OK 
button. See Figure 45.

Entering a New  
LSDB.txt File

Figure 43. Entering the new LSDB.txt file fields Excel.

Figure 44. Saving the file as a .txt file.

Figure 45. Click on the OK button on this warning ialog box.
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Microsoft Excel File Examples

Excel then warns of  possible loss of features.  Click on the Yes button. See Figure 46.

Excel then changes the name of the workbook to be LSDBe.txt. See Figure 47.

Excel then asks about saving changes.  Click on the No button. See Figure 48.

Figure 46. Click on the Yes button when this warning dialog box appears.

Figure 47. The workbook with a .txt name.

Figure 48. Click on the No button when this dialog box appears.
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To demonstrate what has been created, open the file with a binary viewer. See Figures 
49 and 50.

Microsoft Excel File Examples

Figure 51 shows the hexadecimal display of the file contents, along with the cor-
responding character glyphs on the right.

Checking File with a 
Binary Viewer

Figure 49. Select the file to be viewed.

Figure 50. Open the file with a binary viewer.

Figure 51. The hexadecimal display of the file contents. 
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Microsoft Excel File Examples

Here are the invisible (non-printing ASCII) characters in the file:  the 09 in the 11th 
character position of the first row;  the 09 in the fifth character position of the second 
row;  and the  0D and 0A in the 13th and 14th character positions of the third row.  ASCII   
09  is the “tab” character.  ASCII  0D and 0A  are the “carriage return” and the “line feed” 
characters.  These carry overs from the old Teletype electromechanical printers are 
used as delimiters between fields (tabs) and end-of-line or record separators (carriage 
return and line feed), often referred to as a “new line” pair.

This format, achieved either through use of Excel as described above or through use of 
the DBEdit program, is compatible with the LinkStart program and the DBEdit program.  

Note: The same format with a “space” character instead of the “tab” character is 
also compatible with the LinkStart program.  The DBEdit program can read such a file, 
but when saving it would  write it with the tab characters.

There are no particular limitations to the number of records that LinkStart can 
work with.

Opening an existing text file is also simple. Figure 52 shows a file with spaces used 
instead of tab characters.

Excel places rather arbitrary dividers, but these are easily changed. See Figure 53.

Figure 52. An existing text file open with spaces instead of tab characters.

Figure 53. Arbitrary dividers can be easily changed.
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Here the extra dividers have been removed by double-clicking. See Figure 54.

Microsoft Excel File Examples

When the final screen appears, click on the Finish button. See Figure 55.

Figure 54. The extra dividers removed.

Figure 55. Click on the Finish button when the final screen appears.
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Microsoft Excel File Examples

The text is now properly imported. See Figure 56. 

This could alternatively have been done by interpreting the input as being space 
delimited to separate fields one and two, and two and three, and removing all the rest 
of the dividers.

Figure 56. Properly formatted text.
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Frequently Asked Questions

1. What are the system requirements?

A laptop computer running Windows XP. The Wi-Fi module and the IntelliRupter 
fault interrupter control module must have the software components for Installer 
Version 1.6.9 or later.

2. Can I install more than one key in an IntelliRupter fault interrupter?

No. This implementation is for the Master encryption key only and allows only one 
key in each IntelliRupter fault interrupter.

3. Can I replace a communication module that has master security keys installed 
in its Wi-Fi module with a new communication module?

Yes. The security configuration is also stored in the base memory module. When a new 
communication module is plugged in to an IntelliRupter fault interrupter, the Wi-Fi 
module reads the security information in the base memory module and resets itself 
to match the local security configuration. For the laptop to connect, it must have the 
correct keys that match the IntelliRupter fault interrupter’s security configuration.

4. Can I configure Wi-Fi security with a Docking Station?

Yes. There is a check box in the Wi-Fi Configuration and Setup dialog box that will 
direct the Wi-Fi module to overwrite the base memory module configuration on next 
power-up. Select that check box, and click on the Apply button when you execute the 
steps outlined in the “Sending Configuration Files” section on page 18.

5. Can I recreate my key files if I loose them?

No. Even when using the same name each time the key files are generated, the Wi-Fi 
key program generates a new encryption.

6. If I lose my key files, is there a back door to unlock the Wi-Fi connection?

No. If the keys have been lost, S&C recommends returning the communication module 
to S&C to have the factory defaults restored.

7. If I lose my key files, is there a back door to unlock the Wi-Fi connection?

No. If the keys have been lost, S&C recommends returning the communication module 
to S&C to have the factory defaults restored.


